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Distribusi Frekuensi  
dan Statistik Deskriptif 
Lainnya 

 
 
 
 
 
 
 
 
 
 
 
 
 
Misalnya seorang penjaga gudang mencatat berapa sak gandum 
keluar dari gudang selama 15 hari kerja, maka diperoleh distribusi 
data seperti berikut. 
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Akan dilakukan statistika deskriptif untuk memperoleh insight 
mengenai data ini. Pertama, data ini perlu diurutkan lebih dahulu. 
Anda bisa mengurutkan secara manual atau menggunakan fitur 
sort dari Excel. 
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2.1 Distribusi Frekuensi  

Atribut deskripsi pertama adalah Range atau jangkauan data. Ini 
adalah nilai data tertinggi dikurangi nilai data terendah, atau dalam 
kasus ini adalah 97 dikurangi dengan 53, yaitu 44. 

Berikut, kita akan mencari distribusi frekuensi. Distribusi frekuensi 
akan membagi data menjadi kelompok numerik, kemudian me-
nampilkan jumlah kemunculan dari data-data di tiap group.  

Pengelompokkan ini biasa disebut kelas. Batas kelas menampilkan 
batas bawah dan batas atas dari kelas. Lebar kelas menyatakan 
jarak antara batas atas dan batas bawah ini.  

Tiap kelas bersifat eksklusif, artinya satu nilai hanya bisa masuk di 
kelas tertentu saja. Selain itu, kelas juga harus bersifat inklusif, 
artinya semua data harus masuk ke kelas. 

Data biasanya dirangkum dalam beberapa kelas, misalnya 5-15 
kelas. Lebar kelas juga harus jelas, misalnya 5, 10, 100, 500, dan 
sebagainya. Formula untuk mengetahui lebar kelas adalah: 

Lebar Kelas = Range / Jumlah Kelas  

Batas kelas biasanya digenapkan, misalnya batas kelas 50 sampai 
59, biasanya memiliki batas asli 49,5 sampai 59,5. Nilai yang 
sama seperti batas atas, biasanya menjadi anggota kelas 
berikutnya. 
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Batas 
Kelas Batas Real  Tally  Frekuensi 

Frekuensi 
Relatif 
(Frekuensi 
dibagi  n) 

Kumulatif
Lebih 
dari 
batas 
bawah 

Kurang 
dari 
batas 
atas  

50-59 49,5-59-5 I I 2 0,13 15 0 
60-69 59,5-69,5 I I I 3 0,20 13 2 
70-79 69,5 - 79,5 I I I I 5 0,33 10 5 
80-89 79,5-89,5 I I I 3 0,20 5 10 
90-99 89,5- 99,5 I  I 2 0,13 2 13 
n (total) 15 0 15 

 
Anda bisa membuat diagram batang dari frekuensi seperti berikut. 

 

Gambar 2.1 Diagram batang dari frekuensi  

Anda juga bisa membuat membuat diagram garis poligon. 

 

Gambar 2.2 Diagram garis poligon  



 22

Anda juga bisa memplot data kumulatif lebih dari batas bawah. 

 

Gambar 2.3 Diagram plot data kumulatif lebih dari batas bawah  

Atau, diagram plot kumulatif kurang dari batas atas. 

 
Gambar 2.4 Diagram kumulatif kurang dari batas atas  

2.2 Tendensi Sentral dari Data Tidak 
Berkelompok 

Tendesi sentral (central tendency) menentukan bagian tengah dari 
data, biasanya mengacu pada nilai tertentu. Mean adalah salah 
satu contoh untuk mengukur tendensi sentral. Parameter-
parameter populasi direpresentasikan dengan huruf kapital, 
sementara statistik dari sampel dilambangkan dengan huruf kecil. 
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2.2.1 Mean 

Pertama, kita akan membahas data-data yang tidak terkelompok, 
misalnya data-data tunggal. Contohnya, ada data sederhana 
jumlah sak gula yang terjual dalam seminggu (7 hari) seperti 
berikut: 3, 7, 7, 4, 1, 8, 5. 

Maka, ini bisa dihitung mean dari sampel dengan rumus berikut. 

n
x

X   

Dimana X bar (X dengan garis di atasnya) adalah mean dari 
sampel, serta x adalah variabel yang dihitung dengan n adalah 
jumlah data. Pada contoh di atas, rata-ratanya adalah (3 + 7+ 7 
+4+ 1+ 8+ 5)/7 = 35/7 = 5. 

Kalau untuk populasi dari mean, tandanya adalah ikon  dengan 
ukuran populasi adalah N. 

Ketika data punya beberapa nilai duplikat, dan ada beberapa yang 
punya bobot tertentu, Anda dapat menggunakan pembobotan. 
Rumusnya adalah frekuensi dikali bobot, lalu dibagi dengan jumlah 
bobot total.  

Jumlah deviasi nilai-nilai data dengan mean selalu menghasilkan 
nilai nol. Atau dengan kata lain memiliki tampilan seperti berikut. 

  0)( x  

Misalnya, kalau ada 3 nilai: 1,3, dan 8. Maka rata-ratanya adalah 
(1+8+3)/3 atau 12/3 = 4. Maka jumlah standar deviasi adalah: 

= (1-4) + (3-4) + (8-4)  

= -3 + (-1) + 4  

= 0 

Ketika menggunakan mean, Anda harus berhati-hati karena mean 
memiliki kekurangan sebagai media untuk mengukur tendensi 
sentral, karena mudah dipengaruhi oleh sedikit nilai yang ekstrim. 
Misalnya, ada 10 nilai rendah, lalu ada satu nilai ekstrim yang 
tinggi bisa meningkatkan nilai mean. 
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2.2.2 Median  

Median adalah nilai tengah dari data ketika diurutkan. Median bisa 
dianggap sebagai urutan tengah secara geometri, sementara mean 
adalah urutan tengah secara aritmetik. Jadi, media ini tidak di-
tentukan oleh besar atau kecilnya data, tapi selalu ada di tengah. 

Untuk menentukan median, Anda bisa mengurutkan data, lalu 
tentukan posisi median dengan menggunakan rumus. 

5,0
2

n

 

Kalau nilainya pecahan, artinya nilainya ada di antara dua nilai, 
karena itu harus dijumlahkan kedua nilai tersebut, baru dibagi 
menjadi dua.  

Misalnya kalau ada 7 nilai (3, 7, 7, 4,1, 8, dan 5). 

Pertama, Anda harus mengurutkannya terlebih dahulu: 

1,3,4,5,7,7,8.  

Urutan datanya adalah jumlah data dibagi dua, ditambahkan 
setengah. Jadi (7/2) + ½ : 4 

Nilai keempat dari urutan adalah 5. 

Jadi mediannya adalah 5. 

2.2.3 Modus (Mode) 

Modus adalah nilai yang paling sering muncul. Dari contoh di atas, 
bisa terlihat bahwa nilai 7 adalah modusnya, karena muncul 2 kali. 

Nilai Kemunculan
1 1
3 1
4 1
5 1
7 2
8 1

Beberapa data tidak memiliki modus yang tunggal, tapi memiliki 
dua atau tiga modus. Pada umumnya, modus ini memang tidak 
menggambarkan sentralitas data, tapi mengetahui angka yang 
paling sering muncul tetap merupakan informasi yang penting. 
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2.2.4 Pengukuran Posisi  

Salah satu pengukuran posisi yang sudah dijelaskan adalah 
median. Tapi, selain median ada beberapa pengukuran lagi. Misal-
nya kuartil yang membagi data menjadi empat bagian.  

 Kuartil pertama atau Q1 adalah posisi data seperempat 
pertama.  

 Kuartil kedua atau Q2 adalah posisi data di tengah (yaitu 
median). 

 Kuartil ketiga atau Q3 adalah posisi data seperempat 
terakhir, atau tiga per empat data. 

Lokasi:  

 Q1 = (n/4)+.5 

 Q2 = (n/2)+.5 

 Q3= (3n/4)+.5 

Kadang ada istilah antarkuartil yang merupakan jarak antara Q3 
dan Q1. Ada juga istilah persentil yang membagi data menjadi 
100.  

2.3 Persebaran Data Tidak Berkelompok  

Persebaran data mengacu kepada penyebaran atau variabilitas 
data. Mengetahui persebaran data sangat penting, karena ini bisa 
menghasilkan informasi tambahan terhadap data. Misalnya, ada 
seorang yang punya nilai rata-rata B, satu orang karena semuanya 
B, satunya karena A dan C nya sama. 

Contohnya, masih data 3, 7, 7, 4, 1, 8, 5 dengan rata-rata adalah 
5.  

2.3.1 Range  

Range adalah nilai tertinggi dibagi nilai terendah, ini menjelaskan 
total jangkauan seluruh data. Misalnya, nilai tertinggi adalah 8, 
sementara nilai terendah adalah 1, maka range adalah 8 -1 atau 7.  
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2.3.2 Deviasi Rata-Rata Populasi 

Deviasi rata-rata menjelaskan jumlah absolut dari nilai dikurangi 
rata-rata dibagi dengan jumlah data.  

Misalnya untuk data di atas, bisa dibuat tabel seperti berikut. 

X µ x-µ |x-µ|
3 5 -2 2
7 5 2 2
7 5 2 2
4 5 -1 1
1 5 -4 4
8 5 3 3
5 5 0 0

Jumlah 14

Gunakan rumus berikut untuk menghitung deviasi rata-rata dari 
sampel. 

N
x ||  

 

Misalnya untuk contoh data di atas, adalah 14 dibagi dengan 7, 
maka hasilnya adalah 2.  

2.3.3 Variansi Populasi dan Standar Deviasi  

Variansi populasi ( 2) menjumlahkan variasi dari mean, rumusnya 
adalah. 

N
X 


2

2 )( 
  

Contohnya untuk data di atas, adalah.  

X µ x-µ (x-µ)2

3 5 -2 4
7 5 2 4
7 5 2 4
4 5 -1 1
1 5 -4 16
8 5 3 9
5 5 0 0

Jumlah 38

38 dibagi dengan 7, hasilnya adalah 5,4. 

Untuk standar deviasi, adalah akar kuadrat dari variansi, yaitu akar 
kuadrat dari 5,4 atau sekitar 2,3.  
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Untuk variansi sampel, simbolnya adalah s2 sementara standar 
deviasi adalah s. 

Rumusnya adalah. 

1
)( 2

2




 
n

xx
S  

Standar deviasi dapat digunakan sebagai ukuran variasi data. 
Aturan standarnya adalah data pada umumnya berbentuk normal 
dengan bentuk seperti bel. 

Untuk data yang simetris, kira-kira 68,26% data akan berada di 
dalam cakupan satu standar deviasi dari meannya, dan 95,44% 
data akan berada di antara dua standar deviasi dari meannya. 

Jadi kalau ada populasi dengan rata-rata populasi µ = 500, dan 
standar deviasi  = 100, maka 95,44 % datanya ada di antara 300 
dan 700. Yaitu dengan jarak mean +- 2  (2 x standar deviasi). 

 

Gambar 2.5 Cakupan data dalam persen untuk  
standar deviasi di antara mean 

2.4 Tendensi Sentral Data Kelompok  

Ketika sebuah data tidak tersedia, atau volumenya tidak gampang 
diatur secara bijian, Anda perlu menggunakan pengelompokan. 
Contohnya, data pertama tadi seperti berikut. 
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Batas Kelas 
Frekuensi 

(f) 
Nilai 

Tengah (x) fx 
50-59 2 54,50 109
60-69 3 64,50 193,5
70-79 5 74,50 372,5
80-89 3 84,50 253,5
90-99 2 94,50 189
Σf 15 Σfx= 1117,5

2.4.1 Mean Kelompok    

Mean kelompok dapat dihitung dengan rumus fx dibagi dengan n. 
Untuk data di atas, maka mean kelompok adalah 1.117, 5 dibagi 
dengan 15 yang hasilnya adalah 74,5. 

2.4.2 Median Kelompok  

Ini sama seperti median biasa, hanya saja karena menggunakan 
kelompok, maka rumus mediannya dihitung seperti berikut. 

)(2 i
f

CFn

L
b

  

Dimana L adalah atas bawah dari kelas median. CFb adalah 
frekuensi relatif sebelum frekuensi median. Dan i adalah interval 
kelas. 

Misalnya untuk data di atas, n/2 adalah 15/2 atau 7,5. 

Maka, digunakan rumus di atas adalah. 

69,5 + 5 = 74,5 

Sehingga, diperoleh median adalah 74,5. 

2.4.3 Modus Kelompok  

Modus Kelompok adalah titik tengah dari kelas yang memiliki 
frekuensi paling tinggi. Pada contoh data di atas, modusnya adalah 
74,5. Modus dan median ini memiliki nilai yang sama, karena 
distribusi di data ini adalah normal.  
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2.5 Skewness 

Distribusi data selain ada yang normal, ada juga yang tidak 
simetris. Data yang tidak simetris ini disebut data yang skew, yang 
berarti data memiliki kecondongan. 

Skewness pada data memiliki dua variasi, yaitu data yang negatif 
dan data yang positif. Kalau skew negatif, maka mean akan 
menjadi ukuran terkecil dari tendensi sentral. 

 

Gambar 2.6 Skew negatif  

Sementara kalau skew positif, mean akan menjadi yang terbesar di 
tendensi sentral. 

 

Gambar 2.7 Skew positif  
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Tingkat kecondongan sebuah kurva bisa diukur menggunakan 
koefisien kecondongan dari Pearson. Ini bisa diterapkan pada data 
sampel atau data populasi. 

Apabila data skew positif, maka mean akan menjadi lebih besar 
daripada median, dan pengukuran koefisiennya positif. Ketika data 
skew negatif, maka mean lebih kecil daripada median, dan 
koefisiennya negatif. Distribusi normal memiliki koefisien pearson 
bernilai nol. 

Rumus koefisien skewness seperti berikut ini. 

deviasidars
medianmeanSkewness

_tan
)(3 

  

2.6 Statistik Deskriptif dengan SPSS  

Berikut, contoh penggunaan SPSS untuk statistik deskriptif, yang 
digunakan untuk memperoleh gambaran data dengan lebih jelas.  

1. Buka SPSS. 

2. Klik pada Variable View untuk memasukkan variabel. 

 

Gambar 2.8 Klik pada Variable View untuk memasukkan variabel  
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3. Masukkan nama variabel, misalnya “Gandum” untuk 
menjelaskan nama variabel jumlah gandum yang terjual 
dari gudang. 

 

Gambar 2.9 Memasukkan nama variabel  

4. Otomatis diberi tipe numeric dengan width 8, dan desimal 
2 oleh SPSS. Anda bisa mengedit lagi ini. 

 

Gambar 2.10 Tipe numerik  

5. Untuk mengganti tipe data, letakkan pointer mouse di 
Type, kemudian klik pada tombol elipsis yang muncul. 



 32

 

Gambar 2.11 Klik pada tombol elipsis yang muncul  

6. Muncul Variable Type, di mana Anda bisa memasukkan 
dan mengganti tipe variabel serta nilai desimal. 

 

Gambar 2.12 Jendela Variable Type  

7. Ganti nilai desimal menjadi 0 di Decimal Places. 

 

Gambar 2.13 Penggantian nilai desimal menjadi nol  
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8. Isikan label untuk data tersebut, kalau perlu isikan di 
kolom Label. 

 

Gambar 2.14 Pengisian label  

9. Atur perataan data di alignment, apakah ke kiri, kanan, 
atau tengah. 

 

Gambar 2.15 Pengaturan data  

10. Klik pada Data View, hingga terlihat tampilan data view 
seperti berikut. 
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Gambar 2.16 Tampilan data view  

11. Masukkan data-data ke dalam kolom Gandum tersebut, 
misalnya data seperti berikut. 
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12. Anda bisa meng-copy paste dari sumber data atau meng-

isikan secara manual. 
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Gambar 2.17 Menyalin data  

13. Kemudian klik menu Analyze > Descriptive Statistics > 
Frequencies untuk mencari tahu frekuensi data. 

 

Gambar 2.18 Klik pada Frequencies  

14. Pilih nama variabel yang baru dibuat, dan masukkan ke 
kanan dengan klik pada panah kanan. 

 

Gambar 2.19 Pemilihan nama variabel di sebelah kanan  
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15. Maka, variabel tersebut masuk ke sebelah kanan. 

 

Gambar 2.20 Variabel masuk ke sebelah kanan  

16. Klik tombol Statistics. 

 

Gambar 2.21 Klik pada tombol Statistics  

17. Muncul jendela Frequencies: Statistics seperti berikut ini. 

 

Gambar 2.22 Jendela Frequencies: Statistics  
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18. Cek pada item-item yang ingin ditampilkan, seperti kuartil, 
tendensi sentral, dan standar deviasi. 

 

Gambar 2.23 Pengecekan pada item yang ingin ditampilkan  

19. Klik Charts kalau mau membuat chart. 

 

Gambar 2.24 Klik Charts  

20. Cek pada Histogram > Show normal curve on histogram. 
Kemudian klik Continue. 
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Gambar 2.25 Klik Show normal curve on histogram  

21. Klik Format untuk memformatnya. 

 

Gambar 2.26 Klik pada Format untuk memformatnya  

22. Klik OK untuk memproses. 

 

Gambar 2.27 Klik pada tombol OK untuk memproses  
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23. Muncul jendela output. Klik dua kali untuk mengaktifkan 
opsi ini. 

 

Gambar 2.28 Klik dua kali untuk mengaktifkan opsi  

24. Anda bisa melihat jendela output menghasilkan output 
yang diprosesnya. 

 

Gambar 2.29 Jendela output menghasilkan output  

25. Di bagian Statistics, Anda bisa melihat jumlah data, serta 
atribut-atribut deskriptif lain yang dipilih, seperti mean, 
median, modus, variansi, standar deviasi, skewness, range, 
nilai di persentil-persentil tertentu. 
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Gambar 2.30 Range di persentil tertentu  

26. Di tabel berikutnya, ada frekuensi dari tiap kemunculan 
data, persentasenya dan nilai kumulatif dari persentase 
tersebut. 

 

Gambar 2.31 Tabel frekuensi dari kemunculan tiap-tiap data  
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27. Di bawahnya ada histogram berisi chart jenis bar, beserta 
dengan diagram normal yang ada. 

 

Gambar 2.32 Diagram normal  

28. Untuk menyimpan output-an ini, klik pada File > Save di 
jendela output. 

 

Gambar 2.33 Klik File > save di jendela output  

29. Isikan nama file di kotak teks Filename. 
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Gambar 2.34 Pengisian nama file di kotak teks File name  

30. Maka, nama yang disimpan akan sama seperti nama di 
title bar. 

 

Gambar 2.35 Nama di title bar terlihat sesuai dengan 
 nama yang disimpan 

31. Anda bisa mengedit output yang sudah dibuat. Misalnya 
untuk mengganti teks, klik dua kali pada item yang ingin 
diganti. 
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Gambar 2.36 Klik dua kali pada nama yang ingin diganti  

32. Klik pada teks yang ingin dibuat, maka muncul formatting 
toolbar, dan kotak bisa diubah. 

 

Gambar 2.37 Kotak diubah  

33. Masukkan teks baru dengan mengetikkannya pada kolom 
tersebut. 
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Gambar 2.38 Memasukkan teks baru dengan  
mengetikkan teks di keyboard  

34. Anda bisa menambahkan yang lain sesuai dengan 
kebutuhan. 

 

Gambar 2.39 Pengeditan median  

35. Klik di sembarang tempat untuk menutup jendela editing 
ini. 
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Gambar 2.40 Klik di sembarang tempat untuk menutup jendela editing 

36. Di grafik, Anda juga dapat mengeditnya. Caranya dengan 
klik dua kali pada chart tersebut. 

 

Gambar 2.41 Klik dua kali pada chart  

37. Maka chart menjadi memiliki arsiran garis miring. 
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Gambar 2.42 Chart memiliki arsiran garis miring  

38. Muncul jendela chart editor untuk mengedit chart ini. 

 

Gambar 2.43 Jendela chart editor untuk mengedit chart 
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39. Klik pada salah satu objek yang ingin diedit, misalnya 
diganti warnanya. Kemudian pilih warna baru di palet yang 
muncul di jendela Properties. 

 

Gambar 2.44 Pengeditan pada palet yang muncul  

40. Maka, warna pada objek yang terpilih akan berubah. 

 

Gambar 2.45 Warna pada objek terpilih berubah  
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41. Anda juga bisa mengedit dan mengganti jenis style pada 
teks. Pilih di combobox yang ada. 

 

Gambar 2.46 Pemilihan di combobox jenis font  

42. Kalau jenis font diubah, Anda bisa langsung melihat 
hasilnya di bagian chart. 

 

Gambar 2.47 Teks berubah di sebelah kanan chart  
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43. Anda bisa mengeksplorasi data untuk melihat deskripsi 
atau penggambaran datanya dengan klik pada Analyze > 
Descriptive Statistics > Explore. 

 

Gambar 2.48 Explore untuk mengeksplorasi Descriptive statistics  

44. Klik pada tombol panah kanan untuk mengambil variabel 
ke Dependent List. 

 

Gambar 2.49 Memasukkan ke Dependent list  

45. Klik tombol Plots. 

 

Gambar 2.50 Klik pada tombol Plots  
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46. Tentukan apa yang mau ditampilkan di Explore: Plots. 

 

Gambar 2.51 Menentukan apa yang mau ditampilkan  

47. Muncul tampilan pertama, yang menentukan data, dan 
mengecek apakah ada data yang hilang. 

 

Gambar 2.52 Pengecekan data  

48. Di Descriptives, Anda bisa melihat mean, dan batas untuk 
95% confidence interval untuk mean. Kemudian atribut lain 
seperti median, variansi, dan standar deviasi. 

 

Gambar 2.53 Descriptives menjelaskan deskripsi data  
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49. Di stem & leaf, Anda bisa melihat plot stem & leaf untuk 
data ini. 

 

Gambar 2.54 Plot stem & leaf  

50. Di diagram tukey box plot, Anda bisa melihat data quartil 
pertama di batas bawah box, mean berupa garis, dan batas 
atas box yang menunjukkan kuartil ketiga.  

 

Gambar 2.55 Diagram box plot tukey  

51. Anda dapat menyimpan file, klik pada File > Save As. 
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Gambar 2.56 File > Save As  

52. Isikan nama file di File name, dan klik Save. 

 

Gambar 2.57 Pengisian nama file di File name untuk menyimpan data 

53. Maka, nama file data yang disimpan, muncul di title bar. 

 

Gambar 2.58 Nama file data yang disimpan muncul di title bar SPSS  
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